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OPC Data Logger Case Study

Logging Data to Microsoft Excel
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Introduction

Intended Audience

This document is intended for people who need to log OPC data to Microsoft Excel. Plain and simple.

Purpose of this document

This document is intended to provoke design decisions prior to implementation.

This document is intended to help facilitate the easiest possible OPC Data Logger configuration, while

realizing the limitations associated with Microsoft Excel, which will result in:
e Allowing all data to be logged
e Preventing the spreadsheet from over-filled

This document will outline a simple data logging scenario along with step-by-step instructions that will

accomplish a solution.
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Data Logging Scenario

Let's begin by listing our requirements:
1. We have several items/tags that we want to log.
2. We want to analyze the logged data later (not in real time)
3. We want to see the data logged in a table format, showing the data between time-frames.

4. We want to see if any data was questionable/bad during a specific time-frame.

Data Format

We will log our data to a single table, as in the following table:

[tem_Name ltem_Value [tem_Quality ltem_Timestamp
Channel1.device.1.Tag1 | 10 192 1/1/2008 12:01:01
Channel1.device.1.Tag1 | 20 192 1/1/2008 12:01:01
Channel1.device.1.Tag2 | 30 192 1/1/2008 12:01:01
Channel1.device.1.Tag1 | 40 192 1/1/2008 12:01:01
Channel1.device.1.Tag1 | 50 192 1/1/2008 12:01:01
Channel1.device.1.Tag3 | 60 192 1/1/2008 12:01:01
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Configuring the OPC Data Logger

Configuration Process

The process for configuring the OPC Data Logger to solve our needs is as follows:

1. Create a connection to our OPC Server.

n

Import/add the Items/Tags that we want to log and specify HOW we want them to be collected.

w

Configure the File for loading within Microsoft Excel.
4. Putting it all together.

We will make this as painless as possible as we will simply use the Wizards.
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Creating a connection to the OPC Server

Open the OPC Data Logger. If this is the first time you have launched the application, the Project Wizard

will automatically launch. Otherwise, let's create a new configuration by choosing New from the File menu.

1. The following steps assume that you are already sat at the Project Wizard main-page:

OPC Data Logger 3.0

PROJECT WIZARD
ERE,

welcomel! this wizard will guide you through the various steps
required to correctly configure the component.

- Data Source (what data will be logged™)
- Data Destination(z) (where to log the data)

- Presentation (how the data should look)

Step-by-step instructions for the most commonly used IDuumu
scengrios are svailzsble here :

Wizard Help

Click Next to continue. ..

Cancel

ous  Next >

m

Click the Next button.
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2. You can give the Project a name, which is not important at this point so hit Next:

OPC Data Logger 3.0

OPC DATA LOGGER 3.0

Enter & name and description for the new Project.

Name
|F‘mjeu:t

Description

Description is optional, but can be useful to describe what the project is
used forfby etc.

Cancel < Previous Mext =
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3. Creating a Data Collector is how you specify the source of your data. In this case we need to

create a new collector that points to an OPC Server:

OPC Data Logger 3.0

OPC DATA LOGGER 3.0

Choose an existing Data Collector to associate with this Project.

More information on Uata Collectors 15 availzble here!

... or, click the button below to ADD a new data collector.

New DataCollector

Cancel < Previous [lext =

Click the New DataCollector button.
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4. The Data Collection Wizard will open:

Add DATA SOURCE Wizard

WL TVl S X DATA COLLECTION WIZARD

SOH‘WOIE®
toolbox-

welcome! this wizard will guide you through the various steps
required to correctly configure the component.

This wizard will help you choose a type of data source, such as
OPC.

More information sbout Dats Collectors 1s availzble here:

Wwizars Help

Click Next to continue. ..

Cancel < Previous Next =

Click the Next button.
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5. Now you can choose the Plugin/driver for the data collection:

Add DATA SOURCE Wizard

=

I VAT S XS DATA COLLECTION WIZARD

—

Choose a Data Collector type

OPC Data Access (2, 3x) Interfface ;I
Interface to OPC DA Servers, for collecting/receiving Data for logging

More information sbout these plugins availzble here!

Cancel < Previous Mext =

Choose OPC Data Access (2.x, 3.x) Interface and click Next.
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6. Now you can name this collector:

Add DATA SOURCE Wizard

VT A VTS R X DATA COLLECTION WIZARD

_r-"-.-'-

Enter & name for the new Data Collector.

Collector
This is simply 3 "Friendly Name® for this data collector.

Cancel < Previous Mext =

This is not too important, so we can accept the name and click Next.
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7. Now we will choose the computer where the OPC Server resides:

Add DATA SOURCE Wizard

OPC DATA LOGGER 3.0

Select a Computer where the Server resides. .

127.0.0.1 |

Cancel < Previous Mext =

Pick the computer from the dropdown box and then click Next.
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8. Now we pick the OPC Server available on the computer:

Add DATA SOURCE Wizard

OPC DATA LOGGER 3.0 DATA COLLECTION WIZARD

Pick the Server you wish to connect to...

! =

OCSTK.DA.S5im.32

o

I Cancel < Previous

Click the Next button to continue.
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9. Now finish the wizard:

Add DATA SOURCE Wizard

OPC DATA LOGGER 3.0 DATA COLLECTION WIZARD

iDOlbOK' Click ‘Finish' to add this component:

Data Collector:
Computer: 127.0.0.1
Server: SWToalbow TOP Server

< Previous Einish

10. An OPC Data Collector has now been defined.
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Importing the Items/Tags

1. After completing the Data Collection Wizard you should now be looking at the Project Wizard

again:

OPC Data Logger 3.0

e

OPC DATA LOGGER 3.0 PROJECT WIZARD

-

Choose an existing Data Collector to associate with this Project.

Collector j

Maore informastion on Data Collectors is svailzsble here.

... or, click the button below to ADD a new dala collector.

@ The collector has been successfully created and will be added to the configuration upon

completion of all wizards. Do you want to add more? if so click the "New Data Collector™
button

Cancel

< Previous Next >

The Data Collector you just added should now be visible and selected in the dropdown. Click
Next.
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2. Now we will import our Items:

OPC Data Logger 3.0

OPC DATA LOGGER 3.0 PROJECTWIZARD

- e

You will need to define the items that you wish to log.

Click the button below to add ltems to the Project.

Cancel < Previous Mext =

Click the Add Items button.
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3. The Group & Items Wizard will open:

Add New GROUP Wizard...

OPC DATA LOGGER 3.0 GROUP & ITEMS WIZARD

SonamG
toolbox

Welcomel! this wizard will guide you through the various steps
required to correctly configure the component.

- Specifying 2 name and description
- Adding, or Importing ltems:

- Import directly from Data Source
- Import from *.csv / Text file

#More information on Groups sre svallsble here:

Wwizard Help

Cancel < Previous Next >

Click Next.
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4. The Items will be added to a Group and the following step allows you to define the name of this

group:
OPC DATA LOGGER 3.0 GROUP & ITEMS WIZARD
Enter @ name and description for the group of items you wish to add.
Group Mame
IGmup

Description
A description is optional, but can be useful to describe why the
group exists and what it is used for etc.

Cancel < Previous Mext =

The group name is not important at this time, so click Next.
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5. Now we will specify HOW we will read the values of these Items:

Add New GROUFP Wizard...

w————

OPC DATA LOGGER 3.0 GROUP & ITEMS WIZARD

How, and how frequently do you want the ltems to be read from the Data Source?

Interval | 250 ::I |msec ﬂ

(*+ Subscription Bazed Reads Behavior
(recommended) {*
" Timer Based Reads

" Triggered Reads

More information on the Fead Methods are availzble here:

Cancel < Previous Mext =

Pick the method that best suits your needs, which is typically the Subscription Based Reads
option. Click Next.
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6. Next we can specify how we want to specify the items to log:

Add New GROUP Wizard...

OPC DATA LOGGER 3.0

How would you like to add items to your group?
i+ Manually choose items to add
" Auto import from Diata Source (Server)

" Auto import from Text file (*.csv)

More information on adding ltems 15 avallable here!

Cancel < Previous Mext =

If you want to log all of the Items available in the OPC Server then press the Auto import from

Data Source (Server) option, otherwise choose Manually choose items to add. Click Next.
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7. The Items list window will open which is where lists the items to log. The list will be empty:

OPC DATA LOGGER 3.0 GROUP & ITEMS WIZARD
Here you C8F B | eChadirg Peport] edit ard rerove deee 10 B0d omr The bat
Nare L Wialie
i e g
Browse for Items to Add »
Add - * Import = Ewpart Befesh - Thee Cowrd: 0
Camosl < Prgvinus  lewt >

Click the Add button at the bottom of the dialog and choose Browse for ltems to Add.
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8. Item Group & Item Browser dialog will open allowing you to browse the available items within

your OPC Server:

% Server Connection - Group & Item Browser

B 127.00.1 +t5ine1: Adding List
E&I Tgolbm‘..TOPSenrer Channel_{_User_Defined Ramp.Ramp1
-kl _System _ Channel_0_lser_Defined. Ramp Ramp2
&= Channel_0_User_Define Channel_{_User_Defined. Ramp.Ramp3
e 15ine5
[ .
[ -
[ .
Count: | 3 | Remove = Sort
< | | I~ Show Attributes
I[TEMS Mame Filter: * ~ Data Type: Unspecfied - AccessRights: Mone -
BRAMCH Mame Filter: * - Cancel |Add Selected... | OK

Simply highlight the items you want to log and press the Add Selected button at the bottom. This
will store these items in a list. You can continue browsing adding more items to this list. When

finished simply click the OK button.
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9. The items will be returned into the previous wizard page:

Page 23 of 41

Add New GROUP Wizard...

OPC DATA LOGGER 3.0

GROUP & ITEMS WIZARD

Here, you can add (including import), edit and remove items to and from the list.

| Value

| Quality

| Simple MName | ttemID | Description
> Channel_0_User_...

0

Channel_0_User ...

Channel_0_User_...

Channel_0_User_...

Channel_0_User_...

aaddd

Channel_0_User ...

0
0
0
0
0

[ e = Y e T

Add ~ Remove ~ Import = Export Refresh -

Cancel

Ttem Count: &

< Previous Mext >

Click Next.
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10. The wizard summary page will be displayed.

Add New GROUFP Wizard...

OPC DATA LOGGER 3.0 GROUP & ITEMS WIZARD

Software S
iDOlbOK' Click ‘Finish’' to add this component:
(Group:
Mame: Group
Description:

tem Count: &
Read Method: Subscription

< Previous Einish

Cancel

Click Finish.

11. The group and items have now been added.
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Configuring the Data & File for use with Microsoft Excel

1. Once the Group & Items wizard closes you will be returned back to the Project Wizard page

where you configure the items. Click Next.

2. We will now configure our Data Storage, which in this case will be our file for Microsoft Excel.

OPC Data Logger 3.0

B A

OPC DATA LOGGER 3.0 “PROJECT WIZARD

The next page will allow you to assign Data Storage locations for this Project

“Data Stores™ are where you log the data to.

Click the button below to add a new Data Storage Location

i Mew Data Storage i

Cancel < Previous Mext =

Click the New Data Storage button.
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3. The Data Storage Wizard will open:

Add New Data Storage Wizard

OPC DATA LOGGER 3.0 DATA STORAGE WIZARD

Software S
iDOlbOK welcomel! this wizard will guide you through the various steps

required to correctly configure the component.

This wizard will help you to =elect a Data Source, and will then help
you to configure a store to that data source.

More information sbout Dats Stores 15 avallable here!

Wwizarg Help

1=
m
(=]

S
=}
1=
m
=
W

Click Next.
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4. We can now pick where to log our data to, we will log to a Text File:

Add New Data Storage Wizard

OPC DATA LOGGER 3.0

Choose a Data Storage Type

Microsoft Access lizt above.
My SCGIL

QDBC

JRACLE

ORACLE (Microsoft Implementation)

SCGL-Server

This is simply a “friendly name” that you can associate to this data store.

Cancel < Previous [lext =

Click the Next button.
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5. We will now configure How the data should look within the file:

Add New Data Storage Wizard

OPC DATA LOGGER 3.0

Choose a Presentation Format to associate with this Data Storage.

[

If the option above is empty, or does not contain a format
that you want, then click on the "New Presentation™
button below to create and define a new Presentation
format.

MNew Presentation I

Cancel < Previous et

Click the New Presentation button.
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6. The Presentation Wizard will open:

Add New Data Presentation (Table/Detail) Wizard

OPC DATA LOGGER 3.0

Software 8
iﬂo-l T Welcomel! this wizard will guide you through the various steps
required to correctly configure the component.

Thiz wizard will help you to pick a general “Layout™ of vour data, i.e.
Tzhle or Detail mode.

Mext, the wizard will help you to configure exactly how you want to
display each element of an ltem, including any formatting.

#ore information on Presentation Formatters 15 svailzble here!

Wwizard Help

Cancel

Click Next.
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7. You can choose between Table and Detail. Let's choose Detail:

Add New Data Presentation (Table/Detail) Wizard

OPC DATA LOGGER 3.0

How do you want your data to
Choose a Presentation style

™ Table Timnestamp
More Info.

Tag

MyTagl
Wy Taz2
MyTazs

e

Cancel

be presented?

Page 30 of 41

F00an 1401 | 1
P0lamli0l 2

22amldnl |3

MyTagl MyTag? MyTagd MyTagd
10 10 100
20 200 200
30 30 300

Vahe Qualiiy  Timestamp

o Gaod 2:00am 1401

2 Good 201 am 14101

o 90l am 1101

Ead

< Previous Mext =

Click the Next button.
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8. You can now give the Presentation formatter a name:

Add New Data Presentation (Table/Detail) Wizard

OPC DATA LOGGER 3.0 3 PRESENTATION WIZARD

Enter & name and description for the new Presentation.

Name

|De¢ailF‘resentatinn

Description

Cancel < Previous Mext =

This is not important at this stage, so click the Next button.
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9. The wizard will prompt to automatically add the columns shown in picture. These columns are

highly recommended for logging:

Add New Data Presentation (Table/Detail) Wizard

OPC DATA LOGGER 3.0

The next page will allow you to choose which columns will be logged.

Tag Vahe Qualily  Timestamp
M+Tazl |1 Good 9.0 17101
My Taz2 2 Good 2:01 2 1101
My Tazs = EBad 2.0 am 1101

The above example contains Value, Quality, and Timestamp for each item.

v Automatically add the piciured columng

Cancel < Previous Mext =

Leave the Automatically add the pictured columns checked and click Next.
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10. The item Attributes that we will log are now displayed where they can added, modify and

removed:
OPC DATA LOGGER 3.0 PRESENTATION WIZARD_

—

Here, you can add, edit, remove and reposition the “Attributes” you wish to log.

. Enabled | Attribute FomatString Diescription
. 4 Timestamp wyyy MMdd hh:mmess. ... LI Timestamp

ftem1D

Walue

Quality

mIEIE
Lo Lo Lo Jle fle
Lo fLe fLe Lo

4 4

Add Remove -

Cancel < Previous Mext =

Simply click Next.
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11. The summary page will be shown:

Add New Data Presentation (Table/Detail) Wizard

OPC DATA LOGGER 3.0 PRESENTATION WIZARD
somm - Click ‘Finish' to add this component:
Data Presentation:
Mame: DetailPresentation
Style: Detail
Description:
Cancel < Previous  Einish

Click Finish.
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Page 35 of 41

12. We will now return to the Data Storage Wizard but this time the Detail presentation format we

just added will be automatically selected in the dropdown:

Bl W Dol & ol e deipe W il

ol

OPC DATA LOGGER 3.0

DATA STORAGE WIZARD

Chosd § Pregerdaior Formgt i 355003 «F fu DaE Sorage

I DetailPresentation

[~

# e optior ahove 1§ et o oS mot Cortae § foreat
ot you wart Per Chok or e New Fresertador
b Dl 1 CTRENE B0 SR § ree FrEsartanor

<« Prewows  Newt =

Click Next to proceed.
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13. We can now specify the file for use with Microsoft Excel:

gl N {2l & Sl v W et

OPC DATA LOGGER 3.0 DATA STORAGE WIZARD

Filename |c\myFile cav Browse J ! Dper th

(i) ¥ Open Filz in Shared Mode

F g hiooe E o gty
[y~ Column Separator I&,mma B ;I
* Apperd
[ g < Previnags  Newt >

a. Make sure that the filename ends with CSV.

b. Open File in Shared Mode should be checked. This will allow you to log data to the file

while also allowing Microsoft Excel to open the file in a read-only mode.
c. Column Separator needs to be Comma.

d. Click Next.
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14. The summary page will be displayed:

Add New Data Storage Wizard

OPC DATA LOGGER 3.0 __;I:E DATA STORAGE WIZARD

Software 8
'QO" - Click ‘Finish' to add this component:
Data Storage:
TextFileLogger: TextFileLogger
File: c:\myFile cav

Presertation: Detail Presentation

Cancel < Previous Einish

Click Finish.
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Putting it all together

1. When the Data Storage Wizard closes you will be returned to the Project Wizard. Simply click the

Next button.

2. We will now specify that this configuration will log data to just the Microsoft Excel file we have

previously created:

OPC Data Logger 3.0

OPC DATA LOGGER 3.0 PROJECTWIZARD

.F-Jl E _r.__--

Wwhich data store(s) should this project log to? You add multiple by clicking on the Add button below the list.

Data Store Name | Enabled

TextFileLogger

Add = Remove -

Cancel < Previous Mext =

NOTE: You could also log to other places too, such as other files and/or databases and you would
simply list them in this window.

Click the Next button to continue.

Software Toolbox  148A East Charles Street TOLL FREE: 888-665-3678
International Corporate  Matthews, NC 28105 USA GLOBAL: 704-849-2773
Headquarters, USA  www.softwaretoolbox.com FAX: 704-849-6388




Page 39 of 41

Soﬁware®
toolbox-

3. The summary page will be displayed:

OPC Data Logger 3.0

PROJECT- WIZARD

iDO“)OK' Click ‘Finish' to add this component:
Project:
Mame: Project
Description:

Data Collector: Collector

Cancel < Previous Einish

Click Finish.

The OPC Data Logger has now been configured and each of the components the various wizards added

will be shown in the configuration tree on the left-side of the window:

= 4 SWToalben OpcOniaLogge
- Gioba Corfgurabon
= .4 Duta Collechion
5 Collector
= j Duta Pressrtabion
= [ Detail Mode
Detail Presentation
B Tatve lode
= @ Dwta Storage
@ TextFileLogger
= 4" Taggen
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Logging Data and Loading into Microsoft Excel

To test the configuration, simply click on the Test Run icon on the toolbar.

Likewise, you can actually start logging the data by choosing Start Logging from the Logging menu. This

will cause the OPC Data Logger Service to start logging the data full-time.

After a short while you can open the file within Excel. The quickest and easiest method is to simply open

the properties of the text file by right clicking on it from the configuration treeview:

Ele EMt Jow Tosk Logprg Dndews Selp
gd 3 4 Mo Nasdevoes Ptetae 8

[

- % SWTsolbex Opc DL ngges
- o Global Corfigueaiion
£ Dma Collection
£y Colector
- | Data Pressrtation
: D Miooe
Dt il P rmmari v —
B o e Dot il =g i
| Caia Storage
. - TextfileLogger Fie | Hesder | Fomer | Sparning | Diek Spece
= o ¥ Taggers
iy Soheduted
Facumng
M oo tee B ﬂ Open Fi|e|
- Wl Pramots :
B Fromat 1

1 rivndggist giiom

37 W Oper Fis w Shared Moge
F iz Mos F oreativng,

T i Cosrme Saparator I omma

o bpparid

Within the Text File Properties screen you can click on the Open File button. This should cause the file to

open directly within Microsoft Excel.
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Alternatively, open Microsoft Excel first and then use the Open option within the File menu and then

locate the *.CSV file being used by the OPC Data Logger.

D13 - B V12007 1200 00 PM
| A | B | ¢ [ D E T F T =i »
1 |temName Value Quality  Timestamp
2 |Channel_0_user_defined Ramp Ramp1 10 192 17172007
3 |Channel_0_user_defined Ramp.Ramp1 il 192 1/1/2007| s
4 |Channel_0_user_defined Ramp.Ramp1 12 192 1/1/2007| [ m
5 |Channel_0_user_defined. Ramp.Ramp1 13 192 1/1/2007|
6 |Channel_0_user_defined Ramp.Ramp1 14 192 1/1/2007| ¢ Connect t Micoseft Ofce Oriine
7 |Channel_0_user_defined Ramp.Ramp1 15 192 1/1/2007| ¢ Get the l@est news about using Ewcel
8 |Channel_0_user_defined Ramp.Ramp1 16 192 17172007 o butomancally update tie st Fom the el
9 |Channel_0_user_defined Ramp.Ramp1 17 192 1/1/2007|
10 |Channel_0_user_defined Ramp.Ramp1 18 192 1/1/2007|
11 |Channel_0_user_defined Ramp Ramp1 19 192 1/1/2007 Somrch for:
12 |Channel_0_user_defined Ramp.Ramp1 20 192 1/1/2007|
13 |Channel 0 user defined Ramp.Ramp1 21 192 1/1/2007) Exaepie: Frit sore San one copy”
"
% Open |
" L L
L OPCServer Test_FCIF wie
3 - meme_list_fom _ewcel to go e _detalogger cev
;- ems_ist_fom_ewcel W _go o _detalogger twt
2 o e
g . _] Creste a mew workbook, .
H r
H r
x r
rid
H r
H -
n r
3
n r
” r
u
w 4 o w' Sheetl [ Sheet [ Sheetd / |¢
2

Sum= 1 1/ 243190 T
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